
ANALISIS DE ADAPTACIÓN DE IMPEDANCIAS Y FILTRADO DE SEÑALES CON 

TECNOLOGÍA DE MICROCINTAS EN LA BANDA DE 2.4 GHZ 

 

 

 

ANEXO A.  MANUAL BASICO DE MICROWAVE OFFICE 

 

 

 

DIEGO FERNANDO GALVIS CALAMBÁS 

 MIGUEL FERNANDO GUTIÉRREZ LÓPEZ 
 

Director: Ing. Aldemar Holguín Rojas 

 

Asesor: Ing. Héctor Fabio Bermúdez 

 

 

Universidad del Cauca 

Facultad de Ingeniería Electrónica y Telecomunicaciones 

Departamento de Telecomunicaciones 

Popayán, noviembre de 2008 

 



ANALISIS DE ADAPTACIÓN DE IMPEDANCIAS Y FILTRADO DE SEÑALES CON 

TECNOLOGÍA DE MICROCINTAS EN LA BANDA DE 2.4 GHZ 

 

 

 

 

 

 

ANEXO A.  MANUAL BASICO DE MICROWAVE OFFICE 

 

 

 

 

DIEGO FERNANDO GALVIS CALAMBÁS 

 MIGUEL FERNANDO GUTIÉRREZ LÓPEZ 

 

 

 

Director: Ing. Aldemar Holguín Rojas 

 

Asesor: Ing. Héctor Fabio Bermúdez 

 

 

 

Universidad del Cauca 

Facultad de Ingeniería Electrónica y Telecomunicaciones 

Departamento de Telecomunicaciones 

Popayán, noviembre de 2008 



TABLA DE CONTENIDO 

 

1. ANEXO A.  MANUAL BASICO DE MICROWAVE OFFICE 1 

1.1. PROYECTOS 2 

1.1.1. Creación, Apertura y Guardado de Proyectos 2 

1.2. TRABAJO CON ESQUEMÁTICOS (SCHEMATICS) 3 

1.3. EL NAVEGADOR DE ELEMENTOS 3 

1.4. USO DE PUERTOS Y CABLES 4 

1.4.1. Conexión de Elementos 5 

1.4.2. Edición De Los Parámetros Del Puerto 5 

1.5. CREACIÓN DE GRÁFICOS Y MEDIDAS 5 

2. SIMULACION DE PROYECTOS 6 

2.1. CONFIGURACIÓN DE LA FRECUENCIA 7 

2.2. SINTONIZACIÓN DE CIRCUITOS 7 

3.1. CREACIÓN DEL NUEVO PROYECTO 8 

3.2. CONFIGURACIÓN DE LAS UNIDADES DEL PROYECTO 8 

3.3. CREACIÓN DEL ESQUEMÁTICO 8 

3.4. FRECUENCIAS DE SIMULACIÓN 13 

3.5. CREACIÓN DE UN GRÁFICO Y DIFERENTES MEDIDAS 14 

3.6. SIMULACIÓN DEL CIRCUITO 15 

3.7. SINTONIZACIÓN DEL CIRCUITO 19 

3.8. CREACIÓN DEL ARCHIVO PARA EXPORTAR COMO GERBER 26 

3.9. CREACIÓN DEL LAYOUT 28 

4. USO DE LA HERRAMIENTA TXLINE DE MICROWAVE OFFICE 33 

4.1. Manejo de TXLINE 33 

4.1.1. Txline para el Cálculo de Parámetros de Líneas de Microcinta (Microstrip) 33 

4.1.2. TXLine para el Cálculo de Parámetros de líneas de Microcinta Acopladas 

(Coupled MSLine) 38 

  



INDICE DE FIGURAS 

 

Figura 1 Interfaz de usuario Microwave Office ............................................................. 1 

Figura 2 Interfaz Microwave Office para proyectos ...................................................... 3 

Figura 3 Navegador de esquemáticos ......................................................................... 4 

Figura 4 Vista de elementos ........................................................................................ 5 

Figura 5 Unidades de trabajo en Microwave Office ..................................................... 8 

Figura 6 Ventana de trabajo Microwave Office ............................................................ 9 

Figura 7 Ventana de trabajo II Microwave Office ....................................................... 10 

Figura 8 Adición conectores ventana de trabajo Microwave Office ............................ 10 

Figura 9 Adición puertos ventana de trabajo Microwave Office ................................. 11 

Figura 10 Definición parámetros del sustrato en la ventana de trabajo ........................ 11 

Figura 11 Esquemático filtro de líneas acopladas ....................................................... 13 

Figura 12 Configuración de frecuencias en Microwave Office ..................................... 14 

Figura 13 Selección de parámetros Microwave Office ................................................. 15 

Figura 14 Formas de onda de simulación del filtro con Microwave Office. ................... 15 

Figura 15 Adición de marcadores en la simulación Microwave Office.......................... 16 

Figura 16 Vista de la simulación con marcadores ....................................................... 16 

Figura 17 Búsqueda puntos específicos con marcadores............................................ 17 

Figura 18 Búsqueda puntos específicos con marcadores  II ........................................ 17 

Figura 19 Búsqueda puntos específicos con marcadores III ........................................ 18 

Figura 20 Búsqueda de frecuencias de corte superior e inferior de los filtros .............. 18 

Figura 21 Sintonización del filtro parte I ....................................................................... 19 

Figura 22 Sintonización del filtro parte II ...................................................................... 20 

Figura 23 Sintonización del filtro parte III ..................................................................... 20 

Figura 24 Sintonización del filtro parte IV .................................................................... 21 

Figura 25 Ventana de variable a sintonizar ................................................................. 22 

Figura 26 Ventana de trabajo activado el sintonizador. ............................................... 22 

Figura 27 Variable a sintonizar en la ventana de trabajo ............................................. 22 

Figura 28 Variables a sintonizar en la ventana de trabajo ........................................... 23 

Figura 29 Caracterización del filtro antes de simular. .................................................. 23 

Figura 30 Simulación del filtro sintonizando las variables. ........................................... 24 

Figura 31 Simulación del filtro sintonizando las variables II ......................................... 24 

Figura 32 Simulación del filtro sintonizando las variables III ........................................ 25 

Figura 33 Sintonización final del filtro pasa banda ....................................................... 25 

Figura 34 Creación archivo para exportar como gerber I ............................................. 26 

Figura 35 Creación archivo para exportar como gerber II ............................................ 27 

Figura 36 Creación archivo para exportar como gerber III ........................................... 27 

Figura 37 Creación del Layout .................................................................................... 28 

Figura 38 Layout del circuito ....................................................................................... 28 

Figura 39 Ordenamiento Layout del circuito ................................................................ 29 

Figura 40 Ordenamiento layout del circuito ................................................................. 29 

Figura 41 Layout parcial del filtro................................................................................. 30 

Figura 42 Layout final del filtro pasa banda ................................................................. 30 



Figura 43 Exportar Layout para tallar el circuito .......................................................... 31 

Figura 44 Salvar Layout generado al exportar ............................................................ 31 

Figura 45 Verificación del archivo gerber .................................................................... 32 

Figura 46 Interfaz Herramienta TXLine ....................................................................... 34 

Figura 47 Parámetros en la herramienta TXline.......................................................... 37 

Figura 48 Definición de parámetros herramienta TXline ............................................. 37 

Figura 49 Resultados obtenidos herramienta TXline .................................................. 38 

Figura 50 Interfaz estructura de la microcinta ............................................................. 39 

Figura 51 Inserción parámetros del sustrato en la herramienta TXline I...................... 41 

Figura 52 Inserción parámetros del sustrato en la herramienta TXline II..................... 42 

Figura 53 Cálculo de la impedancia modo par en la herramienta TXLine. .................. 42 

Figura 54 Cálculo de la impedancia modo impar en la herramienta TXLine. ............... 43 

Figura 55 Impedancia par final calculada con herramienta TXline .............................. 43 

Figura 56 Impedancia par final calculada con herramienta TXline .............................. 44 

 

  



INDICE DE TABLAS 

 

Tabla 1 Tipos de gráficos en Microwave Office ............................................................. 6 

Tabla 2 Dimensiones físicas del filtro de líneas acopladas ............................................ 7 

 

  



1 
 

1. ANEXO A.  MANUAL BASICO DE MICROWAVE OFFICE 

 

En esta sección lleva a cabo un acercamiento de la forma más práctica y didáctica posible 
con el objetivo de que el lector de este documento se familiarice con el entorno de 
desarrollo y sea capaz entre otras cosas de: 

 Crear proyectos y guardarlos. 

 Crear esquemáticos que representen los diseños circuitales. 

 Ubicar los elementos circuitales dentro de los esquemáticos. 

 Realizar las simulaciones correspondientes a los circuitos representados en los 
esquemáticos. 

 Visualizar los resultados de las simulaciones en gráficos. 

 Crear los layout correspondientes a los circuitos para realizar su proceso de tallado 

o fabricación (en el caso de circuitos con microcintas). 

Luego de ejecutar el programa se puede visualizar la interfaz de usuario que muestra este 
entorno de visualización se aprecia en la figura 1 con todos los componentes que la 
conforman. 

 

Figura 1 Interfaz de usuario Microwave Office 
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 Barra de título: Es donde se visualiza el nombre que se le pone al proyecto cuando 
se guarda, en este caso como todavía no se ha creado ningún proyecto aparece 
como Untitled Project (Proyecto sin título). 

 Menús: Son un grupo de menús que permiten llevar a cabo el conjunto de 
operaciones en el MWO1 (Microwave Office) y el VSS (Visual System Simulator). 

 Barra de Herramientas: Consta de una serie de botones que proporcionen rápido 
acceso a comandos que son muy usados dentro del entorno (por ejemplo crear un 
nuevo proyecto, guardar un proyecto, etc.).   

 Navegador de proyectos: Contiene toda la colección de datos y de componentes 
que representan el proyecto que se está ejecutando.  Es una estructura tipo árbol 
en la cual se configura todo lo que va a constituir el diseño. 

 Pestañas: Permiten cambiar al navegador de proyectos (Project) por el navegador 
de elementos (Elements) o por el gestor de capas (Layout). 

 Elements: Da acceso a los distintos elementos circuitales y subsistemas con los 
cuales se pueden montar los esquemáticos y hacer las respectivas simulaciones. 

 Layout: Da acceso a las funciones que permiten manejar estructuras 
electromagnéticas. 

 

1.1. PROYECTOS 

El primer paso al trabajar con proyectos es crear un proyecto.  El proyecto es utilizado 
para dar organización y control sobre los diseños en una estructura tipo árbol. 

Contenidos de un proyecto: Todos los componentes y elementos en un proyecto pueden 
ser vistos en la pestaña del navegador de proyectos (Project).  Un proyecto puede 

contener cualquier conjunto de diseños, es quemas lineales o no lineales, estructuras 
electromagnéticas o bloque de sistemas;  cuando se guarda un proyecto también se 
guarda toda la información asociada a él (gráficos, esquemáticos, parámetros, etc) y se 
guarda con la extensión *.emp. 

 

1.1.1. Creación, Apertura y Guardado de Proyectos 
Cuando se ejecuta el entorno AWR se abre un proyecto por defecto denominado “Untitled 

Project”. Sólo un proyecto puede estar activo en el entorno de manera simultánea. 

Después de crear un nombre para el proyecto, se puede comenzar a realizar los diseños 

previstos. Los diseños de las capas se pueden exportar a archivos tipo DFX, GDSII o 

Gerber para ser usados por otros programas. También se pueden optimizar parámetros o 

variables para conseguir la respuesta buscada. 

Para crear un nuevo proyecto elija File>New Project. Nombre el nuevo proyecto eligiendo 
File>Save project as. El nombré será puesto inmediatamente en la barra de títulos. Para 

                                                             
1 Microwave Office 
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continuar trabajando con un proyecto ya existente: File>Open Project y para guardar las 
modificaciones pulse File>Save Project tal y como muestra la figura 2. 

 

Figura 2 Interfaz Microwave Office para proyectos 

1.2. TRABAJO CON ESQUEMÁTICOS (SCHEMATICS) 

Un esquemático es una representación grafica de un circuito, en un proyecto se pueden 
incluir uno o varios esquemáticos. Para crear un esquemático, pulse el botón derecho de 
su ratón sobre Circuit schematics en el navegador de proyecto, tal y como muestra la 
figura 3, y elija New Schematic. Después  se abrirá un esquemático o una ventana en el 
espacio de trabajo y el navegador de proyecto se actualizará con el nuevo elemento, 
mostrando un nuevo subnodo en la posición Circuit Schematics. 

En los subgrupos creados para los esquemáticos están reflejados todos los parámetros y 
opciones que definen y describen el esquemático. En la figura 3 muestra como generar 
los esquemáticos. 

 

1.3. EL NAVEGADOR DE ELEMENTOS 

Esta etiqueta permite acceder a una base de datos muy completa de los grupos 
jerárquicos de elementos de circuitos para los esquemáticos. Las carpetas de librerías y 
datos en este navegador proporcionan una gran cantidad de modelos eléctricos y archivos 
de parámetros S de los fabricantes. 

Los elementos de circuito incluyen modelos, fuentes, puertos, sondas, dispositivos de 
medida, librerías de datos y librerías de modelos que pueden ser situados en el 
esquemático del circuito para simulaciones lineales o no lineales como se ve en la figura 
4. 
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Figura 3 Navegador de esquemáticos 

 

 Para visualizar elementos, pulse la pestaña Element en la esquina izquierda de la 

ventana. 

 Para expandir o contraer las categorías de los diferentes modelos pulse los 
símbolos +/-. Los modelos disponibles se verán en la pantalla inferior. 

 Para llevar un modelo desde esta pantalla inferior al esquemático del circuito 
simplemente púlselo y desplácelo hacia el diagrama sin soltar el ratón, una vez 
colocado en el lugar deseado libere el botón del ratón. 

 Para editar los parámetros del modelo, simplemente pulse dos veces sobre el 
elemento gráfico en el esquema o diagrama de sistema, entonces aparecerá un 
cuadro de diálogo para cambiar los nuevos parámetros. 

 

1.4. USO DE PUERTOS Y CABLES  

Para añadir puertos de entrada y salida a un esquemático, expanda la categoría Ports en 
el navegador de elementos. Así podrá elegir el tipo de puerto que quiere utilizar de entre 
los disponibles en la ventana inferior. 
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Figura 4 Vista de elementos 

También existen teclas de acceso rápido para trabajar con los puertos y la conexión a 
tierra en la barra de herramientas: 

 

1.4.1. Conexión de Elementos 

Para conectar elementos con un cable, posicione el cursor sobre uno de los nodos a 
conectar. Observará que aparece un cursor en forma de cable.  

 

Pulse en esta posición para marcar el inicio del cableado y mueva el ratón hasta el 
siguiente pulsando para terminar la conexión. 

Para cancelar el cableado pulse Esc. 

1.4.2. Edición De Los Parámetros Del Puerto 

Para realizar cambios en los parámetros del puerto por ejemplo  la impedancia de entrada 
del puerto o su identificación, es necesario editarlo. Para ello, se puede pulsar dos veces 
sobre el puerto y se tiene un cuadro de diálogo donde permite realizar estas acciones. 

 

1.5. CREACIÓN DE GRÁFICOS Y MEDIDAS 

Se pueden ver los resultados de nuestros circuitos y sistemas de simulación en varias 
formas gráficas. Sin embargo, antes de llevar a cabo la simulación se debe crear un 
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gráfico y especificar los datos o medidas que se quieren realizar, Las medidas pueden 
incluir, por ejemplo: ganancia, ruido o coeficientes de dispersión (scattering). 

Para crear un gráfico, pulse el botón derecho de su ratón sobre Graphs en el navegador 
de proyectos y elija Add Graph para mostrar una caja de diálogo en la que especifique el 

nombre del gráfico y el tipo. 

La tabla 1 muestra los tipos de gráficos que se pueden utilizar, los más comunes serán los 
rectangulares y carta de Smith. 

Tipo de Gráfico Descripción 

Rectangular Muestra la medida en unos ejes tipo x-y, 
siendo generalmente x la frecuencia 

Constelación Muestra las componentes en fase (parte 
real) y cuadratura (parte imaginaria) de una 

magnitud compleja 

Carta de Smith Muestra la impedancia o admitancias 
pasivas en una carta del coeficiente de 

reflexión de radio unidad 

Polar Muestra el módulo y fase de la medida 

Histograma Muestra la medida como un histograma 

Grafico de antena Muestra la dimensión de barrido de la 
medición como el ángulo de datos y la 

dimensión de la medición como la 
magnitud. 

Tabular Muestra la medida en columnas de 
números, generalmente frente a la 

frecuencia 

Grafico 3D Despliega la medida en un grafico en 3D 

Tabla 1 Tipos de gráficos en Microwave Office 

 

Para especificar los datos que se quieren representar, pulse el botón derecho de su ratón 
sobre el nombre del nuevo gráfico en el navegador de proyecto y elija Add Measurement. 
Una caja de diálogo le permitirá elegir la medida a partir de una completa lista de 
posibilidades: parámetros S, parámetros de admitancia,  ganancia, ruido etc.   

 

2. SIMULACION DE PROYECTOS 

Hacer simulaciones es realmente simple solo elija Simulate > Analyze o haga clic en el 

icono de acceso rápido: 
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La simulación se hace inmediatamente sobre la tabla de frecuencias que está configurada 
con anticipación. 

 

2.1. CONFIGURACIÓN DE LA FRECUENCIA 

Para visualizar correctamente las medidas en los gráficos se debe incluir las frecuencias 
correctas sobre las que se quiere analizar un comportamiento, para esto se debe pulsar el 
nodo Project Options en el navegador de proyecto o elegir Options > Project Options y 
entonces especificar los valores de frecuencias en la caja de diálogo. 

 

2.2. SINTONIZACIÓN DE CIRCUITOS 

La sintonización de un circuito consiste en variar los valores de algunos de sus 
componentes para conseguir cumplir ciertas condiciones de operación. Microwave Office 
permite realizar estas operaciones en tiempo real para decidir con cuales valores 
determinados el circuito muestra un mejor comportamiento. Esto se podrá apreciar mejor 
en los ejemplos que se mostraran a continuación. 

Para ilustrar mejor todo el proceso de trabajo con proyectos para diseño de circuitos se 
han consignado dos ejemplos con los cuales se explica al lector  cómo se hace la 
implementación de los tipos de circuitos con microcintas que se han trabajado en el 
presente proyecto desde su montaje hasta la generación de los archivos gerber para su 

fabricación. 

 

3. FILTRO DE LÍNEAS ACOPLADAS 

Este es el último filtro que se implemento en la monografía, para recordar al lector el 
sustrato de microcinta usado tenia las características correspondientes a la tabla 7 del 
anexo B. 

Las dimensiones físicas del filtro resultantes fueron las mostradas en la  tabla 2: 

i W(mm) S(mm) L(mm) 

1 2,99 0,99 18,11 

2 3,3 5,3 17,84 

3 3,3 5,3 17,84 

4 2,99 0,99 18,11 

Tabla 2 Dimensiones físicas del filtro de líneas acopladas 

Las impedancias terminales tanto de entrada como de salida tenían un ancho de 3,39 mm 
sobre este sustrato y se escogió un largo de 10 mm (solo a las impedancias de entrada y 
salida de un filtro se les puede dar un valor de largo arbitrario). 
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3.1. CREACIÓN DEL NUEVO PROYECTO 

Para crear el nuevo proyecto se elige File > New Project y para grabarlo se usa File > 
Save Project as. El nombre que se elegirá para este ejemplo será Filtro;  cuando el MWO 
es instalado en el PC en la parte correspondiente a Mis Documentos se crea una carpeta 
llamada AWR PROJECTS en esta carpeta es donde quedan almacenados los proyectos 
por defecto. 

 

3.2. CONFIGURACIÓN DE LAS UNIDADES DEL PROYECTO 

Para seleccionar las unidades que usará por defecto el proyecto: Options > Project 
Options. 

Elija la pestaña Global Units y modifique las unidades para que queden como las de la 

figura 5.  Para finalizar y aceptar dichas unidades pulse OK. 

 

Figura 5 Unidades de trabajo en Microwave Office 

 

3.3. CREACIÓN DEL ESQUEMÁTICO 

Para crear el esquemático elija Project > Add Schematic > New Schematic. La nueva 

ventana de la creación del esquema se mostrará en pantalla. Teclee un nombre si lo 
desea sino el nombre por defecto será Schematic 1 y pulse OK. Una ventana de 
esquemático se mostrará en el espacio de trabajo y el esquemático se reflejará bajo el 
nodo de Circuit Schematics en el navegador de proyecto. 

Para colocar los diferentes elementos del circuito pulse la pestaña Elem en la parte 
inferior izquierda del programa, expanda Microstrip en el navegador de elementos 
pulsando el símbolo + a la izquierda del nodo, como se va atrabajar con líneas acopladas 
pulse Coupled Lines para ver el conjunto de elementos disponibles y elija el denominado 
como MCFIL para las líneas acopladas. Arrastre tantos elementos de estos como líneas 
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acopladas sean necesarias a la ventana de trabajo y sitúelos allí. Como se ve en la figura 
6.  

Para las impedancias de entrada y salida como son líneas de microcinta normales se 
selecciona en la parte Lines y se escoge MLIN y se arrastra hacia la ventana de trabajo.  

Como se ve en la figura 7. 

 

 

Figura 6 Ventana de trabajo Microwave Office 

Los elementos de microcinta es necesario conectarlos mediante uniones (Junctions) para 

lo cual en este caso se selecciona la parte Junctions y se escoge el MSTEP$ que solo se 

une entre los elementos de microcintas sin necesidad de parámetros y se arrastra a la 

ventana de trabajo como se aprecia en la figura 8. 
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Figura 7 Ventana de trabajo II Microwave Office 

 

 

Figura 8 Adición conectores ventana de trabajo Microwave Office 
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Para añadir los puertos solo es necesario hacer clic sobre la barra de herramientas en 
Port y arrastrarlos hacia la ventana de trabajo como se ve en la figura 9. 

 

Figura 9 Adición puertos ventana de trabajo Microwave Office 

Por último pero lo más importante, como se está trabajando con elementos Microstrip se 
necesita la definición del sustrato con el cual se va a trabajar, esto se logra ampliando 
Substrates en el navegador de elementos pulsando el símbolo + a la izquierda del nodo y 

pulsando otra vez en Substrates se habilitan los tipos de sustratos que están disponibles, 
en este caso se escoge MSUB y se arrastra hacia la ventana de trabajo como se aprecia 

en la figura 10 en la cual ya se le han dado los parámetros correctos al sustrato. 

 

Figura 10 Definición parámetros del sustrato en la ventana de trabajo 
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Como se ve  son los mismos valores del sustrato a excepción del parámetro RHO el cual 

tiene que ver con el material del conductor que usa el sustrato, de hecho es la resistividad 
del conductor normalizada a la resistividad del oro, en este caso que se ha usado cobre, 
la resistividad del cobre que es igual al inverso de su conductividad es:    

788,5

1

e
 

 y la resistividad del oro que es igual al inverso de su conductividad es: 

710,4

1

e
, 

Entonces la resistividad del cobre dividido la resistividad del oro será igual a:  

6973,06972789,0
788,5

710,4


e

e
 

Para conectar un elemento a otro en el esquema, posicione el elemento de modo que su 
nodo se solape con el nodo del otro elemento. Cuando están correctamente conectados el 
nodo se mostrará como un cuadrado pequeño de color azul. Otra manera de conectar 
elementos es posicionar el ratón en el nodo de uno de los elementos, en este momento la 
herramienta de cableado se activará y pulsando sobre el nodo se podrán unir los 
diferentes elementos.  Una vez conectados todos los elementos del filtro y habiéndoles 
dado todos los parámetros consignados en la tabla 1 a los elementos, el esquemático se 
ve como en la figura 11. 
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Figura 11 Esquemático filtro de líneas acopladas  

 

3.4. FRECUENCIAS DE SIMULACIÓN 

Ahora se debe hacer la correspondiente simulación de este esquemático, para lo cual se 
ubica otra vez el navegador de proyectos, se selecciona Project Options y se escoge la 
pestaña Frequencies y se configuran las frecuencias pulsando Aplicar y luego Aceptar 
como se ve en la figura 12. 
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Figura 12 Configuración de frecuencias en Microwave Office 

 

3.5. CREACIÓN DE UN GRÁFICO Y DIFERENTES MEDIDAS 

Para crear un gráfico en el navegador de proyecto, pulse el botón derecho de su ratón 
sobre Graphs y elija Add Graph. Posteriormente teclee el nombre del grafico si lo desea 
sino por defecto queda Graph 1 y pulse OK. 

Seleccione Rectangular para el tipo de gráfico y pulse OK. El gráfico mostrará una 
ventana en el espacio de trabajo y bajo el nodo Graphs en el navegador de proyectos. 

Para añadir medidas: 

1. Pulse sobre el botón derecho sobre el nodo en el navegador de proyecto y elija 
Add Measurement. 

2. Seleccione los parámetros para los puertos como el tipo de medida (Port 
Parameters). 

o Elija S como la medida (de esta forma estará midiendo los parámetros S 
del circuito creado). Elija “Schematic 1” en Data Source Name (si no se le 
dio nombre al esquematico). 

3. Seleccione “1” en ambos puertos como fuente y destino de la medida, para medir 
el parámetro S11 o de perdidas por retorno. 

4. Seleccione Mag (valor absoluto) como el valor mostrado en pantalla y dB como la 
unidad de trabajo, como se muestra la figura 13. 
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Figura 13 Selección de parámetros Microwave Office 

Se realizan los mismos pasos pero ahora para medir el parámetro S21. Para ello se debe 
cambiar el valor en To Port Index a 2 y pulsar Add para añadir una nueva medida. 

 

3.6. SIMULACIÓN DEL CIRCUITO 

Para simular el circuito pulse la tecla rápida  o bien elija Simulate > Analyze. 

Las formas de onda de respuesta del circuito se aprecian en la figura 14. 

 

Figura 14 Formas de onda de simulación del filtro con Microwave Office. 
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Para visualizar el lugar correcto donde se encuentran las frecuencias de corte es 
necesario añadir marcadores (Markers), se hace clic derecho sobre el grafico el cual 
habilitara un menú en el que se selecciona Add Marker como se puede ver en la figura 15. 

 

Figura 15 Adición de marcadores en la simulación Microwave Office 

Una vez hecho esto el cursor cambia a una especie de cruz la cual se ubica sobre 
cualquier parte de las líneas de respuesta y se hace clic izquierdo con lo cual se activa el 
marcador como se ve en la figura 16.  

 

Figura 16 Vista de la simulación con marcadores 

Como se observa el marcador esta, pero se necesita que indique en que frecuencia se 
marcan -3 dB, para lo cual se hace clic derecho sobre el marcador para que aparezca un 
menú en el cual se selección Search… como muestra la figura 17. 
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Figura 17 Búsqueda puntos específicos con marcadores  

Al presionar Search… se activa una nueva ventana en la cual se puede buscar un 

determinado valor sobre los ejes X y Y, teniendo en cuenta que el eje X corresponde a 
frecuencia y el eje Y corresponde a dB, entonces para buscar una frecuencia de corte se 
selecciona que busque -3 en el eje Y en función absoluta y que lo busque a la derecha del 
marcador como se ve en la figura 18. 

 

Figura 18 Búsqueda puntos específicos con marcadores  II 

Al hacer clic en Search el marcador ubicará la frecuencia de corte inferior como se ve en 

la figura 19. 
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Figura 19 Búsqueda puntos específicos con marcadores III 

Siguiendo un procedimiento análogo se obtiene la frecuencia de corte superior y haciendo 
el cálculo se sabe que la frecuencia central del filtro da sobre 2,435 GHz=2435 MHz por lo 
cual se ubican marcadores en estas frecuencias sobre las dos curvas para saber las 
perdidas máximas y el máximo rechazo en la frecuencia central, lo único que hay que 
tener en cuenta para estos otros dos marcadores es que ahora se va a buscar la 
frecuencia de 2435 MHz, por lo cual el valor será 2435 y el eje de búsqueda será el X;  el 
resultado de este proceso puede ser visualizado en la figura 20. 

 

Figura 20 Búsqueda de frecuencias de corte superior e inferior de los filtros 

Se busca que este filtro tenga frecuencias de corte sobre 2403 MHz y sobre 2447 GHz 
por lo cual se observa que hay una inexactitud que se debe corregir con el proceso de 
sintonización. 
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3.7. SINTONIZACIÓN DEL CIRCUITO 

Para sintonizar un circuito lo primero que se debe hacer es definir variables a sintonizar, 
estas variables servirán para reemplazar los datos numéricos de los parámetros de cada 
elemento circuital.  Se definen variables el proceso es el siguiente: 

Una vez  en la ventana del esquemático del circuito se va a la parte de los menús y 
selecciona el que corresponde a Draw y luego se pulsa Add Equation como se aprecia en 
la figura 21. 

 

Figura 21 Sintonización del filtro parte I 

Ahora aparecerá una especie de cuadro de texto en el cual se puede escribir, como se va 
a sintonizar las partes internas del filtro, es decir las líneas acopladas, se debe observar 
que cada línea acoplada consta de tres parámetros y que el esquemático consta de 
cuatro líneas acopladas, por lo cual se podría pensar que habrían doce variables para 
sintonizar;  pero la ventaja de este filtro es que presenta relaciones de simetría entre sus 
componentes por lo cual las dos primeras líneas acopladas son simétricas respecto a las 
dos últimas y ya no se tendrían doce variables para sintonizar sino solo seis.   

Una vez aparece el cuadro de texto se ingresa la primera variable la cual corresponde al 
ancho de las primeras líneas acopladas por lo cual se ingresa W1=2,99 como se observa 
en la figura 22. 
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Figura 22 Sintonización del filtro parte II 

Repitiendo el proceso otras cinco veces se llega a tener todas las demás variables como 
se muestra en la figura 23. 

 

 

Figura 23 Sintonización del filtro parte III 
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Ahora lo que se debe hacer es asignar los valores de las variables a los parámetros de los 
elementos circuitales, para ello simplemente se hace doble clic sobre el parámetro que se 
va a modificar y se introduce el nombre de la variable apropiada;  al terminar de hacer 
esto se debe tener el circuito como se ve en la figura 24. 

 

Figura 24 Sintonización del filtro parte IV 

Con las variables definidas y puestas ya en su sitio se puede empezar con el proceso de 
sintonización, lo que se debe hacer es establecer las variables como variables de 
sintonización para ello hay dos opciones: 

1. Hacer clic derecho sobre la variable y seleccionar Properties con lo cual se habilita 
la ventana que se muestra en la figura 25, en esa ventana se habilita el check de 
Tune.  Se observara que la variable seleccionada cambia a color azul. 
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Figura 25 Ventana de variable a sintonizar 

2. Ir a la barra de herramientas y seleccionar la que corresponde a Tune Tool como 
se ve en la figura  26, al hacer esto se habilitara una herramienta con forma de 

destornillador. 

 

Figura 26 Ventana de trabajo activado el sintonizador. 

Luego se ubica el destornillador sobre la variable que se quiere sintonizar hasta 
que aparece una especie de signo + sobre ella y se da clic izquierdo con lo cual 
cambia a color azul, como se aprecia en la figura 27. 

 

Figura 27 Variable a sintonizar en la ventana de trabajo 

Una vez hecho esto con las demás se podrán apreciar todas las variables en color azul 
como se  aprecia en la figura 28. 
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Figura 28 Variables a sintonizar en la ventana de trabajo 

Con esto ahora lo que se hace es volver a simular el circuito y observar que el grafico no 
ha cambiado nada como se puede apreciar en la figura 29. 

 

Figura 29 Caracterización del filtro antes de simular. 

Con el gráfico abierto vamos a la barra de Menus y se elige el menú correspondiente a 
Simulate y se selecciona Tune como se ve en la figura 30. 
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Figura 30 Simulación del filtro sintonizando las variables. 

Al hacer esto se habilita la ventana de sintonización en donde aparecen todas las 
variables que se pueden modificar al hacer clic sostenido sobre la palanca 
correspondiente a la variable (al hacer esto cambia de color) y moverla arriba o abajo 
como se aprecia en la figura 31. 

 

Figura 31 Simulación del filtro sintonizando las variables II 

Solo para mostrar cómo cambia la grafica al modificar cualquier variable se va a 
establecer en su valor máximo la variable antes seleccionada S1 como se ve en la figura 

32. 
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Figura 32 Simulación del filtro sintonizando las variables III 

Es evidente como se ha distorsionado, por lo cual este proceso debe hacerse con tacto y 
paciencia hasta lograr mejorar la grafica y alcanzar una respuesta deseada.  Resultaría 
muy extenso consignar todas las sintonizaciones que se le hicieron al circuito hasta 
obtener la respuesta que se buscaba, se muestra el resultado final de la sintonización en 
la figura 33. 

 

Figura 33 Sintonización final del filtro pasa banda 

Con base en la experimentación para sintonizar este tipo de circuito se establecieron una 
serie de reglas sobre como es el efecto de cada variable sobre la respuesta de este tipo 
de filtro, las cuales se presentan a continuación: 

S2 permite cuadrar el tamaño del ancho de banda. 

S1 permite mejorar la máxima transferencia de potencia y aumentar las perdidas por 
retorno. 
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L2 permite correr el ancho de banda, si se disminuye el ancho de banda se corre a la 
derecha mientras que si se aumenta el ancho de banda se corre hacia la izquierda. 

L1 permite corre el ancho de banda, si se disminuye el ancho de banda se corre a la 
derecha mientras que si se aumenta el ancho de banda se corre hacia la izquierda.  Pero 
la diferencia es que esta variable solo puede sintonizarse muy levemente ya que puede 
distorsionar mucho la forma de la respuesta. 

W2 permite correr las frecuencias de corte superior e inferior, si se aumenta estas 
frecuencias se corren hacia la izquierda y si se disminuye se corren a la derecha. 

W1 permite correr la frecuencia de corte inferior, si se aumenta la frecuencia de corte se 
corre hacia la izquierda y si se disminuye se corre a la derecha. 

 

3.8. CREACIÓN DEL ARCHIVO PARA EXPORTAR COMO GERBER 

Una vez se tiene el esquemático listo y sintonizado, el último paso es crear el archivo 
gerber que es necesario para la fabricación del circuito.  Para crear el archivo gerber  se 
va a la sección de Menús y se ubica el menú Options, una vez ahí se pulsa en Drawing 
Layers como  muestra  la figura 34. 

 

Figura 34 Creación archivo para exportar como gerber I 

Una vez pulsado aparecerá la ventana que se ve en la figura 35, una vez ahí se pulsa clic 
derecho sobre Drawing Layer 2D y aparece un menú en el que se selecciona New Gerber 
File Export Mapping como se ve en la misma figura. 
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Figura 35 Creación archivo para exportar como gerber II 

 

Hecho esto se puede ver el nuevo archivo para exportar Gerber, el cual aparece por 
defecto con nombre FileMap1(Gerber) como se ve en la figura 36. 

 

Figura 36 Creación archivo para exportar como gerber III 

Ahora se cierra esa ventana y ubicándose nuevamente en el esquemático haciendo clic 
sobre él en la sección de Circuit Schematics del navegador del proyecto. 
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3.9. CREACIÓN DEL LAYOUT 

Una vez hecho lo anterior vamos a la sección de menús y damos clic sobre el menú View 
y luego sobre New Layout View como se ve en la figura 37. 

 

 

Figura 37 Creación del Layout  

Al hacer esto se crea una nueva ventana con el Layout del circuito como se ve en la figura 
38, este Layout es una muestra de cómo va a quedar el circuito cuando se haga el 

correspondiente tallado. 

 

Figura 38 Layout del circuito 

Como se puede ver este layout es muy desordenado, para ordenarlo lo que hacemos es 

seleccionar todo dejando oprimido el clic izquierdo del ratón y metiendo todo dentro del 
cuadrado, una vez hecho esto el layout debe verse como en la figura 39. 
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Figura 39 Ordenamiento Layout del circuito 

Al hacer esto se cambia a la sección de los Menús y se elige el correspondiente a Edit y 
selecciona Snap All Together como se ve en la figura 40. 

 

Figura 40 Ordenamiento layout del circuito 

Al hacer esto se verá el layout como en la figura 41. 
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Figura 41 Layout parcial del filtro 

Pero como se ve el layout se ve incompleto entonces lo que se hace es dar clic derecho 
sobre el layout para que se despliegue un menú en el cual se selecciona View All con lo 
cual se obtiene el layout que se ve en la figura 42. 

 

 

Figura 42 Layout final del filtro pasa banda 

 

3.10. CREACIÓN DEL ARCHIVO GERBER 

El layout anterior es el que se va a exportar como archivo gerber para mandarlo a fabricar, 
para hacer esto vamos a la sección de Menús y se selecciona el menú Layout y luego se 
pulsa Export… como se ve en la figura 43. 
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Figura 43 Exportar Layout para tallar el circuito 

Al pulsar en Export… aparecerá una ventana en la cual se podrá seleccionar donde se va 

a guardar el archivo, el nombre y el tipo.  Como se ve en la figura 44 se ha escogido que 
el archivo se guarde en el escritorio, con nombre filtro y con tipo de archivo gerber. 

 

Figura 44 Salvar Layout generado al exportar 

Al dar guardar el archivo gerber aparece en el escritorio como se ve en la figura 45. 
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Figura 45 Verificación del archivo gerber 

Este archivo si se abre con una herramienta como el WordPad se podrá ver que es un 

archivo de coordenadas X y Y que permite que la maquina que va a llevar a cabo el 
tallado lo realice con absoluta precisión. 
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4. USO DE LA HERRAMIENTA TXLINE DE MICROWAVE OFFICE 

 

Esta aplicación es muy útil en el proceso de diseño de circuitos de microondas usando 
microstrip, es un programa que facilita el engorroso proceso que es determinar las 
dimensiones físicas de las líneas de microcinta a partir de las propiedades del material 
(sustrato) y de las características eléctricas de los circuitos de microondas.  Para ilustrar 
este aspecto se debe examinar el caso de las líneas de microcinta no acopladas, se 

puede observar en las ecuaciones de la sección 2.1.1 que para hallar la relación 
h

w
 se 

debe conocer la impedancia característica de la línea (
0Z ) y la constante dieléctrica del 

sustrato ( r ), luego se debe establecer la constante dieléctrica efectiva 
re  a partir de las 

ecuaciones expuestas en la sección 2.1.2.  Al realizar los cálculos se le debe añadir los 
efectos del espesor del conductor (t) usando las ecuaciones de la sección 2.2 obteniendo 

así la verdadera relación 
h

w
 y la verdadera constante dieléctrica efectiva 

re ;  después de 

enumerar estos pasos y observar con detenimiento las ecuaciones se puede apreciar lo 
demorado (aunque no complicado) de realizar esta serie de cálculos “a mano”, por lo cual 
es más práctico recurrir a esta herramienta.  En el caso de las microcintas acopladas el 
proceso es muchísimo más complejo porque en este caso hay que suponer valores de las 
dimensiones físicas del ancho (W) de las líneas y del espaciamiento (S) entre ellas para 
obtener dos parámetros u=W/h y g=S/h (donde h es el espesor del dieléctrico) con los 
cuales a partir de las ecuaciones expuestas en dicha sección variarlos hasta obtener los 
valores adecuados de impedancia en modo par y de impedancia en modo impar 
simultáneamente, se cree que solo viendo dichas ecuaciones el lector se podrá hacer una 
idea de lo sumamente complejo que resultaría este proceso ya que sería un número 
indeterminado de iteraciones por ensayo y error, a decir verdad este proceso en este 
proyecto no se hizo “a mano” por lo engorroso del mismo, de no haber encontrado la 
herramienta TXLine se debería haber realizado otra aplicación con el fin de agilizar este 
proceso. 

 

4.1. Manejo de TXLINE 

Cuando se abre la ventana de acceso de TXLine se pueden apreciar una serie de 

pestañas en la parte superior las cuales permiten tener acceso a una diversa cantidad de 

cálculos y aplicaciones, pero para este caso específico solo se han examinado dos de 

ellas. 

 

4.1.1. Txline para el Cálculo de Parámetros de Líneas de Microcinta (Microstrip) 

La primera es la pestaña MICROSTRIP la cual se muestra por defecto cuando se abre la 

herramienta;  si se observa la figura 46 se muestra la interfaz gráfica de esta sección, en 

la parte superior derecha de ella se aprecia la estructura general de una línea de 

microcinta con los respectivos parámetros que se deben tener en cuenta para su diseño.  

Al lado de esta se encuentran los campos en los cuales se deben escoger los parámetros 
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del material (Material Parameters), esta es la parte que se refiere a las características del 

sustrato sobre el cual se está trabajando. 

 

Figura 46 Interfaz Herramienta TXLine 

El primer campo que puede ser apreciado es el dieléctrico (Dielectric), el cual se refiere al 

material dieléctrico del sustrato y en ese campo se muestran una serie de opciones de 

dieléctricos para que el usuario escoja el que va a usar, aunque aquí se aprecian unos 

cuantos dieléctricos entre ellos el aire, el aluminio, el germanio, etc;  una vez se escoge la 

opción apropiada el sistema carga las características del dieléctrico automáticamente, 

pero el caso más común es que el sustrato que se va a ser usado no aparezca en las 

opciones de este campo en cuyo caso es indiferente la opción que se escoja en este 

parámetro.  Antes de continuar con los dos parámetros siguientes es relevante decir que 

estos parámetros solo serán modificados en el caso en que el sustrato que se va a usar 

no sea uno de los dieléctricos que vienen por defecto. 

El segundo campo que puede ser apreciado es el correspondiente a la constante 

dieléctrica del sustrato (Dielectric constant), en el cual se debe escribir la constante 

dieléctrica del material a usar. 

El tercer campo que puede ser apreciado es el correspondiente a la tangente de pérdidas 

(Loss Tangent) del dieléctrico, en el cual se debe escribir la tangente de pérdidas del 

material a usar o el factor de pérdidas (Loss Factor) que es como aparece en los sustratos 

de algunos fabricantes como Taconic. 

El cuarto campo aparece dentro de la sección de las características del conductor y es el 

campo en el cual se debe seleccionar el conductor  que se va a utilizar, en este campo 

aparecen conductores tales como el oro, la plata, el cobre, etc;  una vez seleccionado el 

conductor se carga en el siguiente campo la conductividad del mismo, aunque  

normalmente el conductor más usado por los fabricantes de materiales  es el cobre, 
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también se podría usar un material que no aparezca en los materiales aquí listados en 

cuyo caso este campo no tendría importancia. 

El quinto campo corresponde a la principal característica del conductor y es el 

correspondiente a la conductividad del mismo, la cual debe ser escrita de ser un 

conductor de los que no vienen cargados en la herramienta. 

Una vez que se cargan los parámetros del material, se puede proceder a realizar los 

cálculos que se requieran en el diseño de los circuitos.  Para este fin, la segunda parte de 

esta sección de la herramienta permite calcular las características físicas de las líneas de 

microcinta a partir de las características eléctricas o viceversa;  esta sección consta de 

una serie de campos que deben ser  llenados con el fin de realizar los cálculos. 

Sección de características eléctricas: 

El primer campo de esta sección corresponde a la impedancia de la línea (Impedance) la 

cual solo viene en unidades de Ohms. 

El segundo campo es el correspondiente a la frecuencia de trabajo (Frequency) cuyas 

unidades vienen normalmente en GHz pero pueden ser modificadas de acuerdo a las 

necesidades del usuario. 

El tercer campo es el correspondiente a la longitud eléctrica de la línea (Electrical Length) 

la cual puede ser configurada en grados o en radianes, en este punto se debe hacer una 

aclaración muy importante y es que si se hace una remisión a la monografía se debe 

recordar que en las microcintas los largos de las líneas se calculan a partir de la longitud 

de onda guiada sobre el material.  Para calcular esta longitud de onda guiada basta 

recordar que la distancia entre dos máximos en una onda sinusoidal es 360º o pi radianes, 

lo cual no es otra cosa que una longitud de onda;  para hacer el cálculo de la longitud de 

onda guiada sobre el material se  debe ingresar  el valor de 360º o de 3,14159… radianes 

en este campo. 

El cuarto campo es el correspondiente a la constante de fase sobre el material (Phase 

constant) y es uno de los campos que no pueden ser modificados ya que es una campo 

en el cual se expone un cálculo y no uno de los que sirven para realizar alguno. 

El quinto campo es el correspondiente a la constante dieléctrica efectiva sobre el material 

(Effective Diel. Const.) y también es uno de los campos inmodificables que solo sirven 

para la exposición de un resultado. 

El sexto campo es el correspondiente a las perdidas sobre el material (Loss) y también es 

uno de los inmodificables. 

Sección de características físicas: 

El primer campo de esta sección es el correspondiente a la longitud física  de la línea 

(Physical Length), es decir que largo tendrá  la línea en la práctica sus unidades podrán 
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ser de cualquier unidad métrica pero normalmente la más usada es la de milímetros, lo 

mismo sucede con las unidades de las demás características físicas de esta sección. 

El segundo campo es el correspondiente al ancho de la línea de microcinta (width). 

El tercer campo corresponde al espesor  del dieléctrico (height), que es uno de los 

parámetros de referencia que vienen en el sustrato por parte del fabricante. 

El cuarto campo corresponde al espesor del conductor (thickness) que es el otro 

parámetro de referencia del material. 

Como se puede apreciar en la interfaz existe una flecha hacia la izquierda y otra flecha 

hacia la derecha, estas flechas son botones y permiten realizar los cálculos dependiendo 

de la dirección;  para aclarar el tema, en el caso de la flecha hacia la izquierda se pueden 

obtener los parámetros de la izquierda (los eléctricos) a partir de los de la derecha (los 

físicos), análogamente el botón flecha hacia la derecha permite realizar los cálculos pero 

en sentido contrario. 

Para explicar mejor cómo se diseñan circuitos de microondas en microstrip, se debe 

entender  que en los diseños teóricos se cuenta con una serie de parámetros conocidos, 

los cuales son listados a continuación. 

Parámetros del material: 

El material por ser una línea de microcinta consta de dos elementos el dieléctrico y el 

conductor;  por parte del dieléctrico se cuenta con la constante dieléctrica, el factor de 

perdidas o tangente de perdidas y el espesor del mismo, mientras que en el caso del 

conductor se cuenta con la conductividad del conductor y con el espesor del mismo. 

Características eléctricas: 

En el diseño de circuito de microondas normalmente los procesos de diseño llevan a 

obtener como resultado la impedancia de la línea, por lo cual esta se debe contar como 

un parámetro conocido, así mismo se debe tener seleccionada la frecuencia de trabajo y 

como normalmente las longitudes físicas de línea son múltiplos de la longitud de onda, 

entonces se debe seleccionar como longitud eléctrica 360º o 3,14159… radianes, para 

obtener la longitud de onda guiada en el material y posteriormente multiplicar esa longitud 

física por ¼, 1/8, o por el factor que se necesite como longitud de línea. 

Para que quede totalmente claro el manejo de la herramienta, a continuación se expone 

un ejemplo en el cual se expone como hacer cálculos con la misma. 

Usando un sustrato con las siguientes características correspondientes a la tabla 7 del 

anexo B. 

Calcular las dimensiones físicas que debería tener una microcinta fabricada en este 

sustrato, que trabaje sobre 1,5 GHz con un largo de un cuarto de la longitud de onda 

guiada sobre el sustrato para que la línea posea una impedancia de 75 Ohms. 
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Se abre la herramienta e introduce los parámetros del sustrato como se ve en la figura 47. 

 

Figura 47 Parámetros en la herramienta TXline 

Nota:  Se debe observar que el parámetro dieléctrico no se ha cambiado debido a que el 

sustrato con que se va a trabajar es muy especifico, también debe verse que las unidades 

de las características físicas de la microcinta fueron cambiadas a mm ya que esas son las 

unidades del espesor del dieléctrico (h) y del espesor del conductor (t). 

Una vez hecho esto se ingresan los otros datos, en la parte de impedancia se ingresa la 

impedancia dada (75 Ohms), en frecuencia se debe ingresar la frecuencia de trabajo (1,5 

GHz) y en longitud eléctrica como el ejercicio  dice que el largo debe ser de un cuarto de 

longitud de onda entonces se debe ingresar 90º como se ve en la figura 48. 

 

Figura 48 Definición de parámetros herramienta TXline 
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Nota: Cuando se está trabajando con filtros pasa banda la frecuencia de trabajo será 

obviamente la frecuencia central. 

Hecho esto solo queda realizar los cálculos para ello simplemente se pulsa el botón flecha 

hacia la derecha, los resultados se pueden apreciar en la figura 49. 

 

Figura 49 Resultados obtenidos herramienta TXline 

Como se ve en la figura 49, la microcinta resultante tendría un ancho de 1,62 mm y un 

largo de 30,99 mm, además otro resultado que es bastante utilizado es la constante 

dieléctrica efectiva sobre el sustrato, la cual tiene un valor 2,6 aproximadamente. 

4.1.2. TXLine para el Cálculo de Parámetros de líneas de Microcinta Acopladas 

(Coupled MSLine) 

Es la séptima pestaña en la parte superior de la herramienta, una vez seleccionada esta 

pestaña se podrá apreciar una interfaz como la mostrada en la figura 50, si se aprecia con 

detenimiento esta interfaz se puede observar que existen muy pocas diferencias entre 

esta nueva interfaz con respecto a la interfaz de microstrip, aparte de mostrar obviamente 

una nueva gráfica que corresponde a la estructura de las líneas de microcinta acopladas 

se puede apreciar que todos los campos son similares a parte de la existencia de una 

nueva característica física que es la correspondiente al espaciamiento entre las líneas 

conductoras (gap). 
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Figura 50 Interfaz estructura de la microcinta 

En el aspecto interactivo de esta interfaz se puede apreciar también que solo existe un 

botón flecha en un sentido, una flecha en sentido hacia la izquierda, es decir que con 

microcintas acopladas solo se pueden hacer cálculos de las características eléctricas 

sabiendo las características físicas.  Además se puede observar en la parte inferior de la 

interfaz la existencia de dos radio buttons que corresponden al modo par (even mode) y al 

modo impar (odd mode);  se debe recordar al lector que en microcintas acopladas existen 

dos modos de operación casi TEM que son precisamente los nombrados anteriormente y 

que en cada uno de estos modos el par de líneas acopladas presentan impedancias 

diferentes, por lo cual en el diseño de circuitos con esta estructura se debe tener claro el 

modo de operación. 

De igual manera para entender mejor el trabajo con circuitos de microondas que usan 

este tipo de estructura, se tratara de hacer una explicación detallada a continuación. 

Para los parámetros físicos del material es válida todavía la explicación de la sección 

anterior ya que las características del material no han cambiado, lo único que va a 

cambiar es la forma de usarlo. 

En cuanto a las características eléctricas se debe recordar que las líneas acopladas se 

analizan en dos modos de trabajo y los diseños teóricos de circuitos de microondas que 

usan esta estructura con microcintas conducirán a obtener como resultado dos 

impedancias para cada par de líneas acopladas, por lo cual se debe tener como 

parámetros conocidos las impedancias en modo par e impar de las líneas.  Con esto el 

proceso de diseño es mucho mas engorroso que en la forma anterior ya que teniendo 

como datos conocidos las características del material, la frecuencia de trabajo y las 

impedancias de modo par e impar, se debe seleccionar un modo y empezar a “sintonizar” 
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por ensayo y error valores de ancho (W) y espaciamiento de las microcintas (S) hasta 

obtener simultáneamente los valores más cercanos para las impedancias en los dos 

modos de trabajo. 

Para hacer este trabajo más sencillo después de mucha experimentación se han obtenido 

unas reglas con las cuales cuadrar estas impedancias. 

Reglas con respecto al ancho (width) de las microcintas acopladas 

1. Si el ancho de las líneas acopladas (width) se aumenta tanto la impedancia en 

modo par como la impedancia en modo impar disminuyen, dicho en lenguaje más 
práctico: 

Si w↑↑ →  Ze↓↓ y Zo↓↓ 

2. Si el ancho de las líneas acopladas (width) se disminuye tanto la impedancia en 

modo par como la impedancia en modo impar aumentan;  dicho en lenguaje más 
práctico: 

Si w↓↓ →  Ze↑↑ y Zo↑↑ 

Reglas con respecto al espaciamiento entre las líneas (S) de las microcintas 

acopladas 

1. Si el espaciamiento o gap entre las líneas acopladas (S) se aumenta, la 
impedancia en modo par disminuye y la impedancia en modo impar aumenta;  
dicho en lenguaje más práctico: 

Si S↑↑ →  Ze↓↓ y Zo↑↑ 

2. Si el espaciamiento o gap entre las líneas acopladas (S) se disminuye, la 
impedancia en modo par aumenta y la impedancia en modo impar disminuye;  
dicho en lenguaje más práctico: 

Si S↓↓ →  Ze↑↑ y Zo↓↓ 

Nota: Como el lector puede darse cuenta, del largo físico no se ha hablado nada y esto 
ocurre porque el largo es un dato que se puede ingresar y a partir de él obtener el largo 
eléctrico, pero en la práctica no se sabe el largo físico por lo cual en nuestro caso el largo 
ha sido calculado usando las ecuaciones de diseño de la sección de microcintas 
acopladas y construyendo una aplicación como se puede apreciar en los ejemplos de la 
monografía. 

Para dar mayor claridad al respecto del uso de la herramienta se hará el siguiente ejemplo 
de cálculo. 

Usando un sustrato con las siguientes características: 

Constante dieléctrica = 3,5 

Espesor del dieléctrico (h) = 1,52 mm 

Espesor del conductor (t) = 0,035 mm En este caso se ha usado cobre 
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Factor de pérdidas (Tangente de perdidas) = 0,0018 

Calcular el largo y el ancho de un par de líneas de microcinta acopladas fabricadas en 

este sustrato, al trabajar a 2 GHz para que las líneas posean una impedancia en modo 

par (even) de 100 Ohm y una impedancia en modo impar (odd) de 60 Ohms en 

simultaneo. 

Se abre la herramienta e introduce los parámetros del sustrato como se ve en la figura 51. 

 

Figura 51 Inserción parámetros del sustrato en la herramienta TXline I 

Ahora se ingresan los otros datos, en la parte de frecuencia se debe ingresar la frecuencia 

de trabajo (2 GHz), en Width y Gap se ingresan cualquier par de valores ya que como se 

dijo anteriormente estos se van a variar hasta que demos con los valores más cercanos a 

las impedancias en modos par e impar como se ve en la figura 52. 

 



42 
 

Figura 52 Inserción parámetros del sustrato en la herramienta TXline II 

Los campos impedancia, longitud eléctrica y longitud física no se han tocado y además 

hay dos radio buttons en la parte inferior de la interfaz los cuales permiten hacer los 

cálculos de impedancia en modo par e impedancia en modo impar, para empezar se 

calcula la impedancia en modo par con los datos tal como están en la grafica anterior 

usando el botón flecha a la izquierda, el resultado se muestra en la figura 53. 

 

Figura 53 Cálculo de la impedancia modo par en la herramienta TXLine. 

Como se puede observar el resultado de impedancia en modo par con un ancho (W) de 2 

mm y con un espaciamiento (S) de 1 mm es igual a 77,74 Ohms, ahora sin modificar 

ningún dato vamos a la parte inferior y activamos el radio button Odd Mode y presionamos 

el botón flecha a la izquierda para obtener el valor de la impedancia en modo impar como 

se ve en la figura 54. 
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Figura 54 Cálculo de la impedancia modo impar en la herramienta TXLine.  

Como se puede apreciar la impedancia en modo impar es de 53,2 Ohms con un ancho 

(W) de 2 mm y con un espaciamiento (S) de 1 mm;  las impedancias que se buscan son 

100 Ohms en modo par y 60 en modo impar por lo cual vemos que todavía no se está 

cerca de ambos valores, para cuadrarlos se deben seguir las reglas que se han visto en 

esta sección con respecto al ancho y al espaciamiento de las líneas e ir variando S y W 

hasta obtener los valores más cercanos a los buscados.  El proceso por ser de ensayo y 

error puede resultar un poco extenso y no se va a mostrar por completo, es pertinente 

solo mostrar el resultado final del mismo, en la figura 55 se puede ver la impedancia en 

modo par y en la figura 56 se puede ver la impedancia en modo impar. 

 

Figura 55 Impedancia par final calculada con herramienta TXline 
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Figura 56 Impedancia par final calculada con herramienta TXline 

Como se puede observar con un ancho (W) igual a 1,35 mm y un espaciamiento (S) igual 
a 0,75 mm se han obtenido unas impedancias en modo par e impar de 100,22 y 60,13 
Ohms respectivamente, las cuales son muy cercanas a los valores buscados que eran de 
100 Ohms en modo par y de 60 Ohms en modo impar.  Adicionalmente en las graficas 
también se pueden observar dos parámetros que han sido utilizados en los ejercicios del 
trabajo de grado y son los correspondientes a las constantes dieléctricas efectivas en 
modo par e impar, en el ejemplo la constante dieléctrica efectiva en modo par es de 2,76 y 
la constante dieléctrica efectiva en modo impar es de 2,33. 


